<table>
<thead>
<tr>
<th>Revision History</th>
</tr>
</thead>
<tbody>
<tr>
<td>September 2006</td>
</tr>
<tr>
<td>March 2007</td>
</tr>
<tr>
<td>September 2007</td>
</tr>
<tr>
<td>March 2008</td>
</tr>
<tr>
<td>October 2008</td>
</tr>
<tr>
<td>March 2009</td>
</tr>
<tr>
<td>September 2009</td>
</tr>
<tr>
<td>March 2010</td>
</tr>
<tr>
<td>September 2010</td>
</tr>
<tr>
<td>April 2011</td>
</tr>
<tr>
<td>September 2011</td>
</tr>
<tr>
<td>March 2012</td>
</tr>
<tr>
<td>September 2012</td>
</tr>
<tr>
<td>March 2013</td>
</tr>
<tr>
<td>September 2013</td>
</tr>
<tr>
<td>March 2014</td>
</tr>
<tr>
<td>October 2014</td>
</tr>
<tr>
<td>March 2015</td>
</tr>
<tr>
<td>September 2015</td>
</tr>
</tbody>
</table>
## Overview

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal Processing Toolbox Product Description</td>
<td>1-2</td>
</tr>
<tr>
<td>Key Features</td>
<td>1-2</td>
</tr>
</tbody>
</table>

## Basic Signal Processing Concepts

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Representing Signals</td>
<td>2-2</td>
</tr>
<tr>
<td>Numeric Arrays</td>
<td>2-2</td>
</tr>
<tr>
<td>Vector Representation</td>
<td>2-2</td>
</tr>
<tr>
<td>Waveform Generation: Time Vectors and Sinusoids</td>
<td>2-4</td>
</tr>
<tr>
<td>Impulse, Step, and Ramp Functions</td>
<td>2-6</td>
</tr>
<tr>
<td>Multichannel Signals</td>
<td>2-9</td>
</tr>
<tr>
<td>Common Periodic Waveforms</td>
<td>2-10</td>
</tr>
<tr>
<td>Common Aperiodic Waveforms</td>
<td>2-12</td>
</tr>
<tr>
<td>The pulstran Function</td>
<td>2-14</td>
</tr>
<tr>
<td>The Sinc Function</td>
<td>2-16</td>
</tr>
<tr>
<td>The Dirichlet Function</td>
<td>2-18</td>
</tr>
<tr>
<td>Working with Data</td>
<td>2-20</td>
</tr>
<tr>
<td>Data Precision</td>
<td>2-20</td>
</tr>
</tbody>
</table>
Design a Filter with fdesign and filterbuilder

Filter Design Process Overview ........................................ 3-2
Design a Filter Using fdesign ........................................... 3-3
Design a Filter Using filterbuilder ............................... 3-8

Filter Design with the FDATool GUI

Introduction ................................................................. 4-2
Designing the Filter ....................................................... 4-3
Analyzing the Filter ....................................................... 4-7
Designing Additional Filters ............................................. 4-9
Viewing and Annotating the Filter ............................. 4-10
  Viewing the Filter in FVTool ....................................... 4-10
  Using FVTool for Annotation ................................... 4-14
Exporting Filters from FDATool ............................... 4-16
  Filtering with dfilt ................................................. 4-17
Designing Filters Using Command Line Functions .... 4-20
Overview
Signal Processing Toolbox Product Description

Perform signal processing and analysis

Signal Processing Toolbox provides functions and apps to generate, measure, transform, filter, and visualize signals. The toolbox includes algorithms for resampling, smoothing, and synchronizing signals, designing and analyzing filters, estimating power spectra, and measuring peaks, bandwidth, and distortion. The toolbox also includes parametric and linear predictive modeling algorithms. You can use Signal Processing Toolbox to analyze and compare signals in time, frequency, and time-frequency domains, identify patterns and trends, extract features, and develop and validate custom algorithms to gain insight into your data.

Key Features

- Signal transforms including fast Fourier transform (FFT), short-time Fourier transform (STFT), and Hilbert transform
- FIR and IIR filter design and analysis
- Measurements such as transition and pulse metrics, band power, bandwidth, and distortion
- Power spectrum estimation algorithms and data windowing functions
- Statistical signal measurements such as autocorrelation and cross-correlation
- Linear prediction and parametric time series modeling
- Waveform and pulse generation and data resampling functions
Basic Signal Processing Concepts

- “Representing Signals” on page 2-2
- “Waveform Generation: Time Vectors and Sinusoids” on page 2-4
- “Impulse, Step, and Ramp Functions” on page 2-6
- “Multichannel Signals” on page 2-9
- “Common Periodic Waveforms” on page 2-10
- “Common Aperiodic Waveforms” on page 2-12
- “The pulstran Function” on page 2-14
- “The Sinc Function” on page 2-16
- “The Dirichlet Function” on page 2-18
- “Working with Data” on page 2-20
- “Selected Bibliography” on page 2-21
Representing Signals

In this section...

“Numeric Arrays” on page 2-2
“Vector Representation” on page 2-2

Numeric Arrays

The central data construct in the MATLAB environment is the numeric array, an ordered collection of real or complex numeric data with two or more dimensions. The basic data objects of signal processing (one-dimensional signals or sequences, multichannel signals, and two-dimensional signals) are all naturally suited to array representation.

Vector Representation

MATLAB represents ordinary one-dimensional sampled data signals, or sequences, as vectors. Vectors are 1-by-n or n-by-1 arrays, where n is the number of samples in the sequence. One way to introduce a sequence is to enter it as a list of elements at the command prompt. The statement

\[ x = \begin{bmatrix} 4 & 3 & 7 & -9 & 1 \end{bmatrix}; \]

creates a simple five-element real sequence in a row vector. Transposition turns the sequence into a column vector

\[ x = x'; \]

\[ x = \begin{bmatrix} 4 \\ 3 \\ 7 \\ -9 \\ 1 \end{bmatrix} \]

Column orientation is preferable for single channel signals because it extends naturally to the multichannel case. For multichannel data, each column of a matrix represents one channel. Each row of such a matrix then corresponds to a sample point. A three-channel signal that consists of \( x \), \( 2x \), and \( x/\pi \) is

\[ y = \begin{bmatrix} x & 2*x & x/\pi \end{bmatrix} \]
y =
    4.0000    8.0000    1.2732
    3.0000    6.0000    0.9549
    7.0000   14.0000    2.2282
   -9.0000  -18.0000   -2.8648
    1.0000    2.0000    0.3183

If the sequence has complex-valued elements, the transpose operator takes the conjugate of the sequence elements. To transform a complex-valued row vector into a column vector without taking conjugates, use the .′ or non-conjugate transpose:

```matlab
x=[1-i 3+i 2+3*i 4-2*i]; % 1-by-4 vector
x=x.'; % 4-by-1 vector
```
Waveform Generation: Time Vectors and Sinusoids

Most toolbox functions require you to begin with a vector representing a time base. Consider generating data with a 1000 Hz sample frequency, for example. An appropriate time vector is

\[ t = (0:0.001:1)' \]

where the MATLAB® colon operator (:) creates a 1001-element row vector that represents time running from 0 to 1 seconds in steps of 1 ms. The transpose operator (') changes the row vector into a column; the semicolon (;) tells MATLAB to compute, but not display, the result.

Given \( t \), you can create a sample signal \( y \) consisting of two sinusoids, one at 50 Hz and one at 120 Hz with twice the amplitude.

\[ y = \sin(2\pi \times 50 \times t) + 2\sin(2\pi \times 120 \times t) \]

The new variable \( y \), formed from vector \( t \), is also 1001 elements long. You can add normally distributed white noise to the signal and plot the first 50 points:

\[ yn = y + 0.5 \times \text{randn(size}(t)); \]
\[ \text{plot}(t(1:50),yn(1:50)) \]
Impulse, Step, and Ramp Functions

Since MATLAB® is a programming language, an endless variety of different signals is possible. Here are some statements that generate a unit impulse, a unit step, a unit ramp, and a unit parabola.

```matlab
t = (-1:0.01:1)';
impulse = t==0;
unitstep = t>=0;
ramp = t.*unitstep;
quad = t.^2.*unitstep;
```

All of these sequences are column vectors that inherit their shapes from \( t \). Plot the sequences.

```matlab
plot(t,[impulse unitstep ramp quad])
```
Generate and plot a square wave with period 0.5 and amplitude 0.81.

```plaintext
sqwave = 0.81*square(4*pi*t);
plot(t,sqwave)
```
Multichannel Signals

Use standard MATLAB array syntax to work with multichannel signals. For example, a multichannel signal consisting of the last three signals generated above is

\[
z = [\text{ramp}_\text{sig} \quad \text{quad}_\text{sig} \quad \text{sq}_\text{wave}];
\]

You can generate a multichannel unit sample function using the outer product operator. For example, a six-element column vector whose first element is one, and whose remaining five elements are zeros, is

\[
a = [1 \quad \text{zeros}(1,5)]';
\]

To duplicate column vector \(a\) into a matrix without performing any multiplication, use the MATLAB \texttt{colon} operator and the \texttt{ones} function:

\[
c = a(:, \text{ones}(1,3));
\]
Common Periodic Waveforms

The toolbox provides functions for generating widely used periodic waveforms:

- **sawtooth** generates a sawtooth wave with peaks at $\pm 1$ and a period of $2\pi$. An optional width parameter specifies a fractional multiple of $2\pi$ at which the signal maximum occurs.

- **square** generates a square wave with a period of $2\pi$. An optional parameter specifies the *duty cycle*, the percent of the period for which the signal is positive.

To generate 1.5 seconds of a 50 Hz sawtooth wave with a sample rate of 10 kHz and plot 0.2 seconds of the generated waveform, use

```matlab
fs = 10e3;
t = 0:1/fs:1.5;
x = sawtooth(2*pi*50*t);
plot(t,x)
axis([0 0.2 -1 1])
```
Common Aperiodic Waveforms

The toolbox also provides functions for generating several widely used aperiodic waveforms:

- `gauspuls` generates a Gaussian-modulated sinusoidal pulse with a specified time, center frequency, and fractional bandwidth. Optional parameters return in-phase and quadrature pulses, the RF signal envelope, and the cutoff time for the trailing pulse envelope.
- `chirp` generates a linear, log, or quadratic swept-frequency cosine signal. An optional parameter specifies alternative sweep methods. An optional parameter, `phi`, allows initial phase to be specified in degrees.

To compute 2 seconds of a linear chirp signal with a sample rate of 1 kHz that starts at DC and crosses 150 Hz at 1 second, use:

```matlab
t = 0:1/1000:2;
y = chirp(t,0,1,150);
```

To plot the spectrogram, use:

```matlab
spectrogram(y,256,250,256,1000,'yaxis')
```
The pulstran Function

The `pulstran` function generates pulse trains from either continuous or sampled prototype pulses. The following example generates a pulse train consisting of the sum of multiple delayed interpolations of a Gaussian pulse. The pulse train is defined to have a sample rate of 50 kHz, a pulse train length of 10 ms, and a pulse repetition rate of 1 kHz; `D` specifies the delay to each pulse repetition in column 1 and an optional attenuation for each repetition in column 2. The pulse train is constructed by passing the name of the `gauspuls` function to `pulstran`, along with additional parameters that specify a 10 kHz Gaussian pulse with 50% bandwidth:

```matlab
T = 0:1/50e3:10e-3;
D = [0:1/1e3:10e-3;0.8.^(0:10)]';
Y = pulstran(T,D,'gauspuls',10e3,0.5);
plot(T,Y)
```
The Sinc Function

The sinc function computes the mathematical sinc function for an input vector or matrix $x$. Viewed as a function of time, or space, the sinc function is the inverse Fourier transform of the rectangular pulse in frequency centered at zero of width $2\pi$ and unit height. The following equation defines the sinc function:

$$\frac{\sin \pi x}{\pi x} = \frac{1}{2\pi} \int_{-\pi}^{\pi} e^{j\omega x} d\omega.$$  

The sinc function has a value of 1 when $x$ is equal to zero, and a value of $\frac{\sin \pi x}{\pi x}$ for all other elements of $x$.

To plot the sinc function for a linearly spaced vector with values ranging from $-5$ to $5$, use the following commands:

```matlab
x = linspace(-5,5);
y = sinc(x);
plot(x,y)
```
The Sinc Function
The Dirichlet Function

The function `diric` computes the Dirichlet function, sometimes called the *periodic sinc* or *aliased sinc* function, for an input vector or matrix `x`. The Dirichlet function is defined by

\[
D(x) = \begin{cases} 
\frac{\sin Nx/2}{N \sin x/2}, & x \neq 2\pi k, \\
(-1)^{k(N-1)}, & x = 2\pi k,
\end{cases}
\]

where `N` is a user-specified positive integer. For `N` odd, the Dirichlet function has a period of `2\pi`; for `N` even, its period is `4\pi`. The magnitude of this function is \(1/N\) times the magnitude of the discrete-time Fourier transform of the `N`-point rectangular window.

To plot the Dirichlet function between 0 and `4\pi` for `N = 7` and `N = 8`, use

```matlab
x = linspace(0,4*pi,300);

subplot(2,1,1)
plot(x/pi,diric(x,7))
title('N = 7')

subplot(2,1,2)
plot(x/pi,diric(x,8))
title('N = 8')
xlabel('x / \pi')
```

```matlab
```

---

2-18
The Dirichlet Function

\[ N = 7 \]

\[ N = 8 \]
Working with Data

Data Precision

All Signal Processing Toolbox functions accept double-precision inputs. If you input single-precision floating-point or integer data types, you should not expect to receive correct results and in many cases, an error will occur. DSP System Toolbox™ and Fixed-Point Designer™ products enable single-precision floating-point and fixed-point support for most dfilt structures.
Algorithm development for Signal Processing Toolbox functions has drawn heavily upon the references listed below. All are recommended to the interested reader who needs to know more about signal processing than is covered in this manual.

References


Design a Filter with fdesign and filterbuilder

- “Filter Design Process Overview” on page 3-2
- “Design a Filter Using fdesign” on page 3-3
- “Design a Filter Using filterbuilder” on page 3-8
Filter Design Process Overview

**Note:** You must have the Signal Processing Toolbox installed to use `fdesign` and `filterbuilder`. Advanced capabilities are available if your installation additionally includes the DSP System Toolbox license. You can verify the presence of both toolboxes by typing `ver` at the command prompt.

Filter design through user-defined specifications is the core of the `fdesign` approach. This specification-centric approach places less emphasis on the choice of specific filter algorithms, and more emphasis on performance during the design a good working filter. For example, you can take a given set of design parameters for the filter, such as a stopband frequency, a passband frequency, and a stopband attenuation, and—using these parameters—design a specification object for the filter. You can then implement the filter using this specification object. Using this approach, it is also possible to compare different algorithms as applied to a set of specifications.

There are two distinct objects involved in filter design:

- Specification Object — Captures the required design parameters of a filter
- Implementation Object — Describes the designed filter; includes the array of coefficients and the filter structure

The distinction between these two objects is at the core of the filter design methodology. The basic attributes of each of these objects are outlined in the following table.

<table>
<thead>
<tr>
<th>Specification Object</th>
<th>Implementation Object</th>
</tr>
</thead>
<tbody>
<tr>
<td>High-level specification</td>
<td>Filter coefficients</td>
</tr>
<tr>
<td>Algorithmic properties</td>
<td>Filter structure</td>
</tr>
</tbody>
</table>

You can run the code in the following examples from the Help browser (select the code, right-click the selection, and choose **Evaluate Selection** from the context menu), or you can enter the code on the MATLAB command line. Before you begin this example, start MATLAB and verify that you have installed the Signal Processing Toolbox software. If you wish to access the full functionality of `fdesign` and `filterbuilder`, you should additionally obtain the DSP System Toolbox software. You can verify the presence of these products by typing `ver` at the command prompt.
Design a Filter Using fdesign

Use the following two steps to design a simple filter.

1. Create a filter specification object.
2. Design your filter.

Design a Filter in Two Steps

Assume that you want to design a bandpass filter. Typically a bandpass filter is defined as shown in the following figure.

![Diagram of a bandpass filter](image)

In this example, a sampling frequency of $F_s = 48$ kHz is used. This bandpass filter has the following specifications, specified here using MATLAB code:

- $A_{\text{stop1}} = 60$; % Attenuation in the first stopband = 60 dB
- $F_{\text{stop1}} = 8400$; % Edge of the stopband = 8400 Hz
- $F_{\text{pass1}} = 10800$; % Edge of the passband = 10800 Hz
- $F_{\text{pass2}} = 15600$; % Closing edge of the passband = 15600 Hz
- $F_{\text{stop2}} = 18000$; % Edge of the second stopband = 18000 Hz
- $A_{\text{stop2}} = 60$; % Attenuation in the second stopband = 60 dB
- $A_{\text{pass}} = 1$; % Amount of ripple allowed in the passband = 1 dB

In the following two steps, these specifications are passed to the `fdesign.bandpass` method as parameters.

Step 1
To create a filter specification object, evaluate the following code at the MATLAB prompt:

```matlab
d = fdesign.bandpass
```

Now, pass the filter specifications that correspond to the default Specification — fst1,fp1,fp2,fst2,ast1,ap,ast2. This example adds fs as the final input argument to specify the sampling frequency of 48 kHz.

```matlab
>> BandPassSpecObj = ...
   fdesign.bandpass('Fst1,Fp1,Fp2,Fst2,Ast1,Ap,Ast2', ...
               F_stop1, F_pass1, F_pass2, F_stop2, A_stop1, A_pass, ...
               A_stop2, 48000)
```

**Note:** The order of the filter is not specified, allowing a degree of freedom for the algorithm design in order to achieve the specification. The design will be a minimum order design.

The specification parameters, such as Fstop1, are all given default values when none are provided. You can change the values of the specification parameters after the filter specification object has been created. For example, if there are two values that need to be changed, Fpass2 and Fstop2, use the set command, which takes the object first, and then the parameter value pairs. Evaluate the following code at the MATLAB prompt:

```matlab
>> set(BandPassSpecObj, 'Fpass2', 15800, 'Fstop2', 18400)
```

BandPassSpecObj is the new filter specification object which contains all the required design parameters, including the filter type.

You may also change parameter values in filter specification objects by accessing them as if they were elements in a struct array.

```matlab
>> BandPassSpecObj.Fpass2=15800;
```

**Step 2**

Design the filter by using the design command. You can access the design methods available for you specification object by calling the designmethods function. For example, in this case, you can execute the command

```matlab
>> designmethods(BandPassSpecObj)
```
Design Methods for class
fdesign.bandpass (Fst1,Fp1,Fp2,Fst2,Ast1,Ap,Ast2):

butter
design_methods
cheby1
design_methods
cheby2
design_methods
ellip
design_methods
equiripple
design_methods
kaiserwin
design_methods

After choosing a design method use, you can evaluate the following at the MATLAB prompt (this example assumes you've chosen 'equiripple'):

>> BandPassFilt = design(BandPassSpecObj, 'equiripple')

BandPassFilt =

    FilterStructure: 'Direct-Form FIR'
    Arithmetic: 'double'
    Numerator: [1x44 double]
    PersistentMemory: false

If you have the DSP System Toolbox installed, you can also design your filter with a filter System object™. To create a filter System object with the same specification object BandPassSpecObj, you can execute the commands

>> designmethods(BandPassSpecObj,...
'SystemObject',true)

Design Methods that support System objects for class
fdesign.bandpass (Fst1,Fp1,Fp2,Fst2,Ast1,Ap,Ast2):

butter
design_methods
design_methods
cheby1
design_methods
design_methods
cheby2
design_methods
cheby2
design_methods
ellip
design_methods
equiripple
design_methods
kaiserwin
design_methods
Design a Filter with fdesign and filterbuilder

```matlab
>> BandPassFiltSysObj = design(BandPassSpecObj, ...
    'equiripple', 'SystemObject', true)
```

System: dsp.FIRFilter

Properties:
- Structure: 'Direct form'
- NumeratorSource: 'Property'
- Numerator: [1x44 double]
- InitialConditions: 0
- FrameBasedProcessing: true

Show fixed-point properties

Available design methods and design options for filter System objects are not necessarily the same as those for filter objects.

**Note:** If you do not specify a design method, a default method will be used. For example, you can execute the command

```matlab
>> BandPassFilt = design(BandPassSpecObj)
```

```
BandPassFilt =
```

- FilterStructure: 'Direct-Form FIR'
- Arithmetic: 'double'
- Numerator: [1x44 double]
- PersistentMemory: false

and a design method will be selected automatically.

To check your work, you can plot the filter magnitude response using the Filter Visualization tool. Verify that all the design parameters are met:

```matlab
>> fvtool(BandPassFilt) %plot the filter magnitude response
```

If you have the DSP System Toolbox installed, the Filter Visualization tool produces the following figure with the dashed red lines indicating the transition bands and unity gain (0 in dB) over the passband.
Design a Filter Using filterbuilder

Filterbuilder presents the option of designing a filter using a GUI dialog box as opposed to the command line instructions. You can use Filterbuilder to design the same bandpass filter designed in the previous section, “Design a Filter Using fdesign” on page 3-3

**Design a Simple Filter in Filterbuilder**

To design the filter using the Filterbuilder GUI:

1. Type the following at the MATLAB prompt:
   ```matlab
   filterbuilder
   ```
2. Select **Bandpass** filter response from the list in the dialog box, and hit the **OK** button.
3. Enter the correct frequencies for \(F_{\text{pass}2}\) and \(F_{\text{stop}2}\), then click **OK**. Here the specification uses normalized frequency, so that the passband and stopband edges are expressed as a fraction of the Nyquist frequency (in this case, 48/2 kHz). The following message appears at the MATLAB prompt:

   The variable ‘Hbp’ has been exported to the command window. 
   If you display the Workspace tab, you see the object Hbp has been placed on your workspace.

4. To check your work, plot the filter magnitude response using the Filter Visualization tool. Verify that all the design parameters are met:
   ```matlab
   fvtool(Hbp) %plot the filter magnitude response
   ```
Note that the dashed red lines on the preceding figure will only appear if you are using the DSP System Toolbox software.
Filter Design with the FDATool GUI

- “Introduction” on page 4-2
- “Designing the Filter” on page 4-3
- “Analyzing the Filter” on page 4-7
- “Designing Additional Filters” on page 4-9
- “Viewing and Annotating the Filter” on page 4-10
- “Exporting Filters from FDATool” on page 4-16
- “Designing Filters Using Command Line Functions” on page 4-20
Introduction

This section describes how to graphically design and implement digital filters using the Signal Processing Toolbox FDATool GUI. Filter design is the process of creating the filter coefficients to meet specific frequency specifications. Filter implementation involves choosing and applying a particular filter structure to those coefficients. Only after both design and implementation have been performed can your data be filtered.

This section includes a brief discussion of applying the completed filter design and filter implementation using MATLAB command line functions, such as `filter`. 
Designing the Filter

This section is a step-by-step introduction to using the Filter Design and Analysis Tool (FDATool) to design an octave-band filter. An octave is the interval between two frequencies having a ratio of 2:1. An octave-band filter is a bandpass filter with high cutoff frequency approximately twice that of the low cutoff frequency. The class of an octave filter is determined by its allowable passband ripple and its stopband attenuation. Refer to the ANSI S1.11–2004 standard for more information.

1. Start FDATool from the MATLAB command line.

\[ \text{fdatool} \]

The FDATool dialog opens with a default filter. Its filter information is summarized in the upper left (Current Filter Information) and its filter specifications are depicted in the upper right. In addition to displaying filter specification, this upper right pane displays filter responses and filter coefficients.

The bottom half of FDATool shows the Filter Design panel, where you specify the filter parameters. Other panels, such as Import filter from workspace and Pole/Zero Editor, which you access with the buttons on the lower left, are also displayed in this area. If you have other products installed, you may see additional buttons.
Note that when you open FDATool, Design Filter is not enabled. You must make a change to the default filter design in order to enable Design Filter. This is true each time you want to change the filter design. Changes to radio button items or drop down menu items such as those under Response Type or Filter Order enable Design Filter immediately. Changes to specifications in text boxes such as Fs, Fpass, and Fstop require you to click outside the text box to enable Design Filter.

2 In the Response Type pane, select Bandpass.

3 In the Design Method pane, select IIR, and then select Butterworth from the selection list.

4 For the Filter Order, select Specify order, and then enter 6.

5 Set the Frequency Specifications as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td>Hz</td>
<td>Units for the parameters</td>
</tr>
<tr>
<td>Fs</td>
<td>48000</td>
<td>Sampling frequency</td>
</tr>
<tr>
<td>Fc1</td>
<td>22</td>
<td>First cutoff frequency (i.e., the frequency preceding the passband at which the magnitude response is 3 dB below the passband gain)</td>
</tr>
</tbody>
</table>
Parameter | Setting | Description
--- | --- | ---
Fc2 | 45 | Second cutoff frequency (i.e., the frequency following the passband at which the magnitude response is 3 dB below the passband gain)

6 After specifying the filter design parameters, click the **Design Filter** button at the bottom of the design panel to compute the filter coefficients. The display updates to show the magnitude response of the designed filter.
Notice that the **Design Filter** button is disabled after you compute the coefficients for your filter design. This button is enabled again if you make any changes to the filter specifications.

7 Click the **Store Filter** button.

8 In the Store Filter dialog, change the filter name to **Bandpass Butterworth-1** and click **OK** to save the filter in the Filter Manager.
Analyzing the Filter

After designing the filter, you can view the following filter responses in the display region by clicking on the associated toolbar button or by selecting the desired response from the Analysis menu.

<table>
<thead>
<tr>
<th>Response</th>
<th>Toolbar Button Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter specifications</td>
<td>![Filter specifications]</td>
</tr>
<tr>
<td>Magnitude response</td>
<td>![Magnitude response]</td>
</tr>
<tr>
<td>Phase response</td>
<td>![Phase response]</td>
</tr>
<tr>
<td>Magnitude and Phase responses</td>
<td>![Magnitude and Phase responses]</td>
</tr>
<tr>
<td>Group delay</td>
<td>![Group delay]</td>
</tr>
<tr>
<td>Phase delay</td>
<td>![Phase delay]</td>
</tr>
<tr>
<td>Impulse response</td>
<td>![Impulse response]</td>
</tr>
<tr>
<td>Step response</td>
<td>![Step response]</td>
</tr>
<tr>
<td>Pole-zero plot</td>
<td>![Pole-zero plot]</td>
</tr>
<tr>
<td>Filter coefficients</td>
<td>![Filter coefficients]</td>
</tr>
<tr>
<td>Filter information</td>
<td>![Filter information]</td>
</tr>
</tbody>
</table>

**Note:** Other analyses are available if you have the DSP System Toolbox product installed.

1. Examine the displayed magnitude response of the filter.
2. Display other responses, as desired. Click the appropriate buttons, shown in the table above or select the desired response from the Analysis menu.
3. Click the **Filter coefficients** button to display the filter coefficients.
Filter Design with the FDATool GUI

Filter Coefficients

Section #1
---------------------
Numerator:
  1
  0
-1
Denominator:
  1
  0.8330156882800398
  0.054573804955603329
Gain:
  0.14070214034995651
---------------------
Designing Additional Filters

You have designed one of the bands of an octave filter bank. This section shows you how to design and save the other nine bands. The following table defines the parameters for the remaining bands. Note that all of the bands use these parameters: Bandpass, IIR – Butterworth, order = 6, Fs = 48000 Hz.

<table>
<thead>
<tr>
<th>Fc1</th>
<th>Fc2</th>
<th>Filter Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>45</td>
<td>89</td>
<td>Bandpass Butterworth-2</td>
</tr>
<tr>
<td>89</td>
<td>178</td>
<td>Bandpass Butterworth-3</td>
</tr>
<tr>
<td>178</td>
<td>355</td>
<td>Bandpass Butterworth-4</td>
</tr>
<tr>
<td>355</td>
<td>708</td>
<td>Bandpass Butterworth-5</td>
</tr>
<tr>
<td>708</td>
<td>1413</td>
<td>Bandpass Butterworth-6</td>
</tr>
<tr>
<td>1413</td>
<td>2818</td>
<td>Bandpass Butterworth-7</td>
</tr>
<tr>
<td>2818</td>
<td>5623</td>
<td>Bandpass Butterworth-8</td>
</tr>
<tr>
<td>5623</td>
<td>11220</td>
<td>Bandpass Butterworth-9</td>
</tr>
<tr>
<td>11220</td>
<td>22387</td>
<td>Bandpass Butterworth-10</td>
</tr>
</tbody>
</table>

1. Using the parameters listed in the table above, for each table row, set the appropriate the Fc1 and Fc2 values.
2. Design the filter by clicking the Design Filter button.
3. Click Store Filter to save the filter.
4. Change the name to the appropriate filter name shown in the table above.
5. Repeat these steps until all 10 filters are designed and stored.
Viewing and Annotating the Filter

**In this section...**

“Viewing the Filter in FVTool” on page 4-10  
“Using FVTool for Annotation” on page 4-14

### Viewing the Filter in FVTool

This section teaches you how to use the Filter Visualization Tool (FVTool) to view the octave-band filter. It also describes how to annotate your filter.

1. Click the **Filter Manager** button to display the Filter Manager, which lists your saved filters.

2. Press Ctrl+click on each filter name to select all the filters, and then click **FVTool**. FVTool opens with the filter responses overlaid for easy comparison. (If you want to view a single filter in FVTool, click the **Full View Analysis** button when that filter is shown in the FDATool display panel or select **View > Filter Visualization Tool**).
3 Change the x-axis scale to logarithmic by selecting **Analysis > Analysis Parameters** to display the Analysis Parameters dialog.

4 Change the **Frequency Scale** to **Log**.

5 Click **OK**.
6 Click the Legend button to turn on the legend, which you can drag to the desired location.
7 Click the **Legend** button again to turn off the legend.

Use the **Zoom** button and drag a rectangle around the first few passbands to zoom in.
Click the **Restore Default View** button to return to the full view.

Display other responses, as desired. (The FVTool Analysis toolbar buttons and **Analysis** menu are the same as in FDATool. See “Analyzing the Filter” on page 4-7 for descriptions of the buttons.

**Using FVTool for Annotation**

FVTool is also useful for doing further analysis, adding annotations, and printing. Available annotations include adding rectangles, text boxes, arrows and lines, and adding data tips.

**Note** Do not close FDATool at this time. You will use it in future sections.
1 Use the toolbar buttons to annotate your response plot. Add a line by clicking one of the line buttons, and then use your mouse to draw the line on your plot.

2 Add a data tip by clicking on a plot at the desired point. The data tip shows the frequency and magnitude at that point.

3 Close FVTool by selecting File > Close.
Exporting Filters from FDATool

FDATool provides a simple way to create filter objects (dfilt) from your filter designs. This is particularly useful for saving your filter design to the MATLAB workspace for use with command line functions. You can also save your filters as MATLAB code by using File > Generate MATLAB code to run in scripts or batch files.

1. In FDATool, click Filter Manager and highlight only the Bandpass Butterworth-1 filter.
2. Select File > Export.
3. Set Export to to Workspace. Set Export as to Objects. In Discrete Filter type Hd1. Click Export to export the first filter in your filter bank to an Hd1 dfilt object in the workspace.

4. Repeat steps 1 through 3 for each of the remaining nine filters. Highlight each filter individually to make it the active filter and change the Discrete Filter name to match the filter number. When you finish you will have 10 dfilt objects in the workspace.

5. Close FDATool by selecting File > Close.
6. On the MATLAB command line, verify that your objects were exported by using the whos command.
Filtering with dfilt

1 Type the following on the MATLAB command line to concatenate your filter bank filter objects into a single dfilt object.

\[
\text{Hd} = [\text{Hd1, Hd2, Hd3, Hd4, Hd5, Hd6, Hd7, Hd8, Hd9, Hd10}];
\]

2 To view the first filter, type \text{Hd(1)}.

\[
\text{Hd}(1)
\]

\[
\text{ans} = \\
\quad \text{FilterStructure: 'Direct-Form II, Second-Order Sections'} \\
\quad \text{sosMatrix: [3x6 double]} \\
\quad \text{ScaleValues: [3.40097054256801e-009;1;1;1]} \\
\quad \text{PersistentMemory: false}
\]

3 A number of methods can be used to view and manipulate the \text{Hd1 dfilt} object. Try the \text{info} command:

\[
\text{info(Hd1)} \quad \% \text{Displays filter information}
\]

Discrete-Time IIR Filter \text{(real)}

\[
\begin{array}{ll}
\text{Filter Structure} & : \text{Direct-Form II, Second-Order Sections} \\
\text{Number of Sections} & : 3 \\
\text{Stable} & : \text{Yes} \\
\text{Linear Phase} & : \text{No}
\end{array}
\]

4 You can open FVTool from the MATLAB command line and specify display parameters as follows.
This produces the same display as step 5 of “Viewing the Filter in FVTool” on page 4-10 above.

Now using the MATLAB command line, create some discrete white Gaussian noise data, which you can then filter using the filter bank.

Plot the filtered data.
Designing Filters Using Command Line Functions

You can specify and design filters at the command line using `fdesign` and `design`. The use of `fdesign` and `design` provides a powerful and efficient way to specify and implement digital filters. With `fdesign` and `design`, digital filter design is a two-step process. In the first step, the user specifies the desired characteristics of the filter and saves those specifications in a Filter Specification Object. In the second step, the user implements the filter as a dfilt object, which can then be used to filter data. As an example of this two-step process, we will design a lowpass filter for data sampled at 20 kHz. The desired passband frequency is 1 kHz with a stopband frequency of 1.2 kHz. We will limit the passband ripple to 1 dB and require 60 dB of attenuation between the passband and stopband frequencies.

1. To specify the filter use `fdesign.lowpass` with the parameters given above. You can copy and paste the following code at the MATLAB command prompt.

   ```matlab
d=fdesign.lowpass('Fp,Fst,Ap,Ast',1000,1200,1,60,20000);
```

2. To design the filter use `design` with the appropriate design methods. In this example, we create FIR equiripple and IIR Butterworth designs and compare the filters' magnitude responses.

   ```matlab
Hd1=design(d,'equiripple'); %FIR equiripple design
Hd2=design(d,'butter'); %Butterworth design
Hd=[Hd1 Hd2];%filter object with both designs
%compare filters
fvtool(Hd,'legend','on'); axis([0 2 -70 10])
```
To determine which filter design methods are available for a given Filter Specification Object, use `designmethods`. For the lowpass filter example above, you have a choice of two FIR and four IIR digital filter designs:

```
designmethods(d)
```

**Design Methods for class fdesign.lowpass (Fp,Fst,Ap,Ast):**

- `butter`
- `cheby1`
- `cheby2`
- `ellip`
- `equiripple`
- `kaiserwin`